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Your Office: Microsoft Office 2016 Volume 1 (Kinser) 

Excel Chapter 1 

 

1) A ________ application is a computer program has a user interface comprised of a grid of 
rows and columns. 
A) database 
B) spreadsheet 
C) matrix 
D) tabular 
Answer:  B 
Diff: 2    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
2) The intersection of a row and column is called a ________. 
A) container 
B) chamber 
C) cubicle 
D) cell 
Answer:  D 
Diff: 1    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
3) A ________ is a grid of columns and rows in which data is entered. 
A) database 
B) presentation 
C) document 
D) worksheet 
Answer:  D 
Diff: 1    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
4) Formulas and functions begin with a(n) ________ sign. 
A) # 
B) = 
C) @ 
D) & 
Answer:  B 
Diff: 2    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
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5) Which of the following is NOT a type of data that can be contained in a cell? 
A) Formulas 
B) Functions 
C) Text 
D) Subroutines 
Answer:  D 
Diff: 3    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  

6) The file extension for Microsoft Excel 2016 workbooks is ________. 
A) .xlx 
B) .xlls 
C) .xls 
D) .xlsx 
Answer:  D 
Diff: 2    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
7) When there are multiple worksheets, you can use the keyboard shortcut Ctrl + ________ to 
move one worksheet to right. 
A) Home 
B) End 
C) PgDn 
D) PgUp 
Answer:  C 
Diff: 2    Page Ref: 330 
Objective:  2. Navigate worksheets and workbooks 
 
8) The keyboard shortcut to move one column to the left is ________. 
A) Shift + Tab 
B) Ctrl + Tab 
C) Tab 
D) Ctrl + Home 
Answer:  A 
Diff: 2    Page Ref: 330 
Objective:  2. Navigate worksheets and workbooks 
 
9) The keyboard shortcut to move to cell A1 is ________. 
A) Home 
B) Shift + Home 
C) Alt + Home 
D) Ctrl + Home 
Answer:  D 
Diff: 2    Page Ref: 330 
Objective:  2. Navigate worksheets and workbooks 
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10) To move right one screen, you would use the keyboard shortcut ________. 
A) PgDn 
B) Shift + PgDn 
C) Ctrl + PgDn 
D) Alt + PgDn 
Answer:  D 
Diff: 3    Page Ref: 330 
Objective:  2. Navigate worksheets and workbooks 

11) A comment is indicated by the presence of a ________ in the upper-right corner of a cell. 
A) red square 
B) green square 
C) red triangle 
D) green triangle 
Answer:  A 
Diff: 2    Page Ref: 332 
Objective:  3. Document your work 
 
12) To insert a comment into a cell, you click New Comment in the:________ tab. 
A) Comments group on the Review 
B) Comments group on the Insert 
C) Documentation group on the Review 
D) Documentation group on the Insert 
Answer:  A 
Diff: 2    Page Ref: 332 
Objective:  3. Document your work 
 
13) Which of the following is NOT an example of worksheet documentation? 
A) Descriptive drop-down documentation menus 
B) Descriptive worksheet names 
C) Descriptive cell labels 
D) Descriptive column titles 
Answer:  A 
Diff: 2    Page Ref: 333 
Objective:  3. Document your work 
 
14) Which of the following is typically NOT contained in a separate documentation worksheet? 
A) Modification dates 
B) Author 
C) Charts 
D) Modification History 
Answer:  C 
Diff: 1    Page Ref: 333 
Objective:  3. Document your work 
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15) The base date for date and time data in Excel 2016 is ________. 
A) January 1, 1000 
B) December 31, 999 
C) December 31, 1899 
D) January 1, 1900 
Answer:  D 
Diff: 3    Page Ref: 334 
Objective:  4. Enter and edit data 

16) Which of the following data types is NOT automatically right-aligned by Excel? 
A) Numeric 
B) Date 
C) Text 
D) Time 
Answer:  C 
Diff: 2    Page Ref: 334 
Objective:  4. Enter and edit data 
 
17) If you enter a date or time that is not recognized, Excel treats the information as ________ 
and left-aligns it in the cell. 
A) Numeric 
B) Text 
C) Date 
D) Time 
Answer:  B 
Diff: 2    Page Ref: 334 
Objective:  4. Enter and edit data 
 
18) If you click ________, the insertion point is displayed in the formula bar. 
A) in a cell 
B) in the formula bar 
C) a worksheet tab 
D) the Home tab 
Answer:  B 
Diff: 2    Page Ref: 334 
Objective:  4. Enter and edit data 
 
19) The keyboard shortcut for Undo is ________. 
A) Ctrl + Y 
B) Ctrl + W 
C) Ctrl + U 
D) Ctrl + Z 
Answer:  D 
Diff: 2    Page Ref: 335 
Objective:  4. Enter and edit data 
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20) To insert a line break or hard return in a cell, you would press ________. 
A) Ctrl + Enter 
B) Enter 
C) Alt + Enter 
D) Shift + Enter 
Answer:  C 
Diff: 3    Page Ref: 336 
Objective:  4. Enter and edit data 

21) You can select a noncontiguous range of cells by pressing and holding the ________ key 
when using it in combination with other navigation keys and/or the mouse. 
A) F7 
B) F5 
C) Alt 
D) Ctrl 
Answer:  D 
Diff: 2    Page Ref: 337 
Objective:  5. Work with cells and cell ranges 
 
22) An example of a range of cells is ________.  
A) A1:A3 
B) A1&A3 
C) A1+A3 
D) A1-A3 
Answer:  A 
Diff: 1    Page Ref: 337 
Objective:  5. Work with cells and cell ranges 
 
23) The Merge & Center button is located in the ________ tab. 
A) Alignment group on the Home 
B) Styles group on the Home 
C) Alignment group on the Layout 
D) Styles group on the Layout 
Answer:  A 
Diff: 3    Page Ref: 343 
Objective:  5. Work with cells and cell ranges 
 
24) To select several contiguous columns, click the header of the first column, ________ the 
header of the last column. 
A) then double-click 
B) then right-click 
C) press and hold Shift, and click 
D) press and hold Ctrl, and click 
Answer:  C 
Diff: 3    Page Ref: 345 
Objective:  5. Work with cells and cell ranges 
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25) To select noncontiguous rows, click the header of the first row, ________ the header of each 
additional row. 
A) then double-click 
B) then right-click 
C) press and hold Shift, and  
D) press and hold Ctrl, and click 
Answer:  D 
Diff: 3    Page Ref: 345 
Objective:  5. Work with cells and cell ranges 

26) After selecting a row, pressing the shortcut key ________ will insert a new row above the 
selected row. 
A) Ctrl + I 
B) Ctrl + + 
C) Ctrl + # 
D) Ctrl + R 
Answer:  B 
Diff: 3    Page Ref: 345 
Objective:  6. Adjust columns and rows 
 
27) In Excel, the height of the rows is measured in ________. 
A) picas 
B) points 
C) pixels 
D) ppm 
Answer:  B 
Diff: 2    Page Ref: 347 
Objective:  6. Adjust columns and rows 
 
28) To change the width of a column, you click Column Width in the ________ tab. 
A) Cells group on the Format tab. 
B) Adjustment group on the Format tab. 
C) Cells group on the Home tab. 
D) Adjustment group on the Home tab. 
Answer:  C 
Diff: 2    Page Ref: 348 
Objective:  6. Adjust columns and rows 
 
29) To AutoFit the width of a column, you click Format and then click AutoFit Column Width in 
the ________ tab. 
A) Cells group on the View 
B) Format group on the View 
C) Cells group on the Home 
D) Format group on the Home 
Answer:  C 
Diff: 2    Page Ref: 348 
Objective:  6. Adjust columns and rows 
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30) If a numerical value is too narrow to be displayed in a cell, a series of ________ characters is 
displayed. 
A) & 
B) @ 
C) % 
D) # 
Answer:  D 
Diff: 2    Page Ref: 349 
Objective:  6. Adjust columns and rows 

31) ________ worksheet tabs identify inactive worksheets. 
A) Green 
B) Gray 
C) White 
D) Blue 
Answer:  B 
Diff: 2    Page Ref: 350 
Objective:  7. Manipulate worksheets and workbooks 
 
32) You can copy a worksheet within a workbook, by ________, and then dragging a copy of the 
worksheet to its new location. 
A) double-clicking the worksheet tab 
B) clicking the worksheet tab, pressing and holding Ctrl 
C) right-clicking the worksheet tab 
D) clicking the worksheet tab, pressing and holding Shift 
Answer:  B 
Diff: 3    Page Ref: 352 
Objective:  7. Manipulate worksheets and workbooks 
 
33) You can rename a worksheet by ________ its tab and then typing the new name. 
A) right-clicking 
B) double-clicking 
C) pressing Ctrl and clicking 
D) clicking 
Answer:  B 
Diff: 2    Page Ref: 353 
Objective:  7. Manipulate worksheets and workbooks 
 
34) Headers and footers contain ________ section(s). 
A) one 
B) two 
C) three 
D) four 
Answer:  C 
Diff: 1    Page Ref: 364 
Objective:  8. Preview, print, and export workbooks 
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35) Normal margins for Excel are ________ inch on the left and right sides of the page. 
A) 0.3 
B) 0.7 
C) 0.75 
D) 0.5 
Answer:  B 
Diff: 3    Page Ref: 365 
Objective:  8. Preview, print, and export workbooks 

36) Worksheets can be oriented to print on paper in one of ________ ways. 
A) two 
B) three 
C) four 
D) five 
Answer:  A 
Diff: 1    Page Ref: 366 
Objective:  8. Preview, print, and export workbooks 
 
37) The default print range in Excel is ________. 
A) Print Selection 
B) Print Entire Workbook 
C) Print Active Print Areas 
D) Print Active Sheets 
Answer:  D 
Diff: 2    Page Ref: 367 
Objective:  8. Preview, print, and export workbooks 
 
38) The file extension PDF stands for ________. 
A) Portable Data File 
B) Portable Document Format 
C) Portable Data Format 
D) Portable Document File 
Answer:  B 
Diff: 2    Page Ref: 367 
Objective:  8. Preview, print, and export workbooks 
 
39) A formula is a built-in program that would be used to find the average of a series of numbers. 
Answer:  FALSE 
Diff: 1    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
40) When using a what-if analysis, you change values in spreadsheet cells to see the effects on 
calculated values of interest. 
Answer:  TRUE 
Diff: 2    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
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41) When collecting data in a spreadsheet, each row contains a record. 
Answer:  TRUE 
Diff: 2    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
42) A worksheet is a file containing at least one workbook. 
Answer:  FALSE 
Diff: 2    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  

43) A function is an equation that produces a result and may contain numbers, operators, text, 
and/or functions. 
Answer:  FALSE 
Diff: 2    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
44) The active worksheet has a white tab with bold letters and a thick bottom border. 
Answer:  TRUE 
Diff: 2    Page Ref: 326 
Objective:  1. Understand spreadsheet terminology and components  
 
45) In Microsoft Excel 2016, workbooks have a file extension of .xlsx. 
Answer:  TRUE 
Diff: 2    Page Ref: 326 
Objective:  1. Understand spreadsheet terminology and components  
 
46) The Ctrl + S shortcut quickly saves your file to the same location as the last save. 
Answer:  TRUE 
Diff: 2    Page Ref: 327 
Objective:  1. Understand spreadsheet terminology and components  
 
47) A cell reference is a combination of a row number followed by a column letter such as 12C. 
Answer:  FALSE 
Diff: 2    Page Ref: 329 
Objective:  2. Navigate worksheets and workbooks 
 
48) Keyboard shortcuts allow rapid navigation in a worksheet without having to use the mouse. 
Answer:  TRUE 
Diff: 2    Page Ref: 329 
Objective:  2. Navigate worksheets and workbooks 
 
49) To move up one screen, you use the Ctrl + PgUp keyboard shortcut. 
Answer:  FALSE 
Diff: 2    Page Ref: 330 
Objective:  2. Navigate worksheets and workbooks 
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50) When using a touch screen, the Excel 2016 commands on the ribbon and in shortcut menus 
are rearranged to accommodate the use of a fingertip. 
Answer:  FALSE 
Diff: 2    Page Ref: 331 
Objective:  2. Navigate worksheets and workbooks 
 
51) A comment is added to an individual cell. 
Answer:  TRUE 
Diff: 2    Page Ref: 332 
Objective:  3. Document your work 
 
52) The dollar sign ($) and comma (,) are stored as part of a numeric cell value. 
Answer:  FALSE 
Diff: 3    Page Ref: 334 
Objective:  4. Enter and edit data 

53) In Excel, date and time data are special forms of numeric data. 
Answer:  TRUE 
Diff: 2    Page Ref: 334 
Objective:  4. Enter and edit data 
 
54) By default, numeric data is right-aligned in a cell. 
Answer:  TRUE 
Diff: 2    Page Ref: 334 
Objective:  4. Enter and edit data 
 
55) By default, text data is center-aligned in a cell. 
Answer:  FALSE 
Diff: 2    Page Ref: 334 
Objective:  4. Enter and edit data 
 
56) Data formatted as a date takes the form of a serial number, with the number 1 representing 
January 1, 1900. 
Answer:  TRUE 
Diff: 2    Page Ref: 334 
Objective:  4. Enter and edit data 
 
57) A noncontiguous cell range consists of multiple cells where all cells are directly adjacent to 
each other. 
Answer:  FALSE 
Diff: 2    Page Ref: 337 
Objective:  5. Work with cells and cell ranges 
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58) A contiguous cell range consists of multiple cells where at least one cell is not directly 
adjacent to other cells. 
Answer:  FALSE 
Diff: 2    Page Ref: 337 
Objective:  5. Work with cells and cell ranges 
 
59) A comment is a temporary storage location where information that was cut or copied is 
stored until you paste, move, or clear the information. 
Answer:  FALSE 
Diff: 2    Page Ref: 337 
Objective:  5. Work with cells and cell ranges 
 
60) A destination cell is the location cell to be modified by a move or paste operation. 
Answer:  TRUE 
Diff: 2    Page Ref: 337 
Objective:  5. Work with cells and cell ranges 
 
61) One of the most efficient ways of moving data from oe cell to another is to drag and drop. 
Answer:  TRUE 
Diff: 2    Page Ref: 340 
Objective:  5. Work with cells and cell ranges 

62) Merge & Center can only be applied to horizontal cell ranges. 
Answer:  FALSE 
Diff: 2    Page Ref: 343 
Objective:  5. Work with cells and cell ranges 
 
63) White space refers to blank areas of a worksheet that do not contain data or documentation, 
regardless of the actual color. 
Answer:  TRUE 
Diff: 2    Page Ref: 345 
Objective:  6. Adjust columns and rows 
 
64) Gray worksheet tabs identify inactive worksheets. 
Answer:  TRUE 
Diff: 3    Page Ref: 350 
Objective:  7. Manipulate worksheets and workbooks 
 
65) If you mistakenly delete a worksheet, you can recover it by pressing Undo. 
Answer:  FALSE 
Diff: 1    Page Ref: 353 
Objective:  7. Manipulate worksheets and workbooks 
 
66) The AutoFill property adjusts the height of a row so that its cell contents fit in the row. 
Answer:  FALSE 
Diff: 2    Page Ref: 354 
Objective:  7. Manipulate worksheets and workbooks 
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67) Page Break Preview allows you to manually adjust the location of page breaks. 
Answer:  TRUE 
Diff: 1    Page Ref: 358 
Objective:  8. Preview, print, and export workbooks 
 
68) Adobe System's PDF reader application CANNOT be used to edit a document that was saved 
with the pdf extension. 
Answer:  TRUE 
Diff: 2    Page Ref: 367 
Objective:  8. Preview, print, and export workbooks 
 
69) The intersection of each row and column is called a(n) ________. 
Answer:  cell 
Diff: 2    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
70) When collecting data in a spreadsheet, each ________ is a field in a record. 
Answer:  column 
Diff: 1    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
71) A(n) ________ is an equation that produces results such as numbers or text. 
Answer:  formula 
Diff: 3    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  

72) A(n) ________ is a built-in program that performs a task such as finding the sum of a series 
of numbers. 
Answer:  function 
Diff: 3    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
73) A(n) ________ is a horizontal set of cells that encompasses all the columns in a worksheet. 
Answer:  row 
Diff: 1    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
74) ________ allows you to examine the outcome of the changes to values in a worksheet. 
Answer:  what-if analysis 
Diff: 3    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
75) When using Excel, a spreadsheet is also referred to as a(n) ________. 
Answer:  worksheet 
Diff: 2    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
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76) The worksheet that is visible in the Excel application window is the ________ worksheet. 
Answer:  active 
Diff: 2    Page Ref: 326 
Objective:  1. Understand spreadsheet terminology and components  
 
77) A file that contains one or more worksheets is a(n) ________. 
Answer:  workbook 
Diff: 2    Page Ref: 326 
Objective:  1. Understand spreadsheet terminology and components  
 
78) The cell that receives an action, such as a click, calculation, or paste is the ________ cell. 
Answer:  active 
Diff: 2    Page Ref: 329 
Objective:  2. Navigate worksheets and workbooks 
 
79) A(n) example of a cell ________ is K12. 
Answer:  reference 
Diff: 2    Page Ref: 329 
Objective:  2. Navigate worksheets and workbooks 
 
80) In ________, the ribbon and shortcut menus are enlarged to make selecting commands with 
your fingertip easier. 
Answer:  touch mode 
Diff: 2    Page Ref: 331 
Objective:  3. Document your work 
 
81) A red triangle in the upper-right corner of a cell indicates the existence of a(n) ________. 
Answer:  comment 
Diff: 2    Page Ref: 332 
Objective:  3. Document your work 

82) ________ data contains numbers and special characters such as the period (.) and hyphen (-). 
Answer:  Numeric 
Diff: 2    Page Ref: 334 
Objective:  4. Enter and edit data 
 
83) ________ data is formatted as a serial number. 
Answer:  Date 
Diff: 2    Page Ref: 334 
Objective:  4. Enter and edit data 
 
84) By default, ________ data is left-aligned in a cell. 
Answer:  text 
Diff: 2    Page Ref: 334 
Objective:  4. Enter and edit data 
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85) Time data is represented as a(n) ________ value. 
Answer:  decimal 
Diff: 2    Page Ref: 334 
Objective:  4. Enter and edit data 
 
86) A(n) ________ cell range consists of cells directly adjacent to one another. 
Answer:  contiguous 
Diff: 2    Page Ref: 337 
Objective:  5. Work with cells and cell ranges 
 
87) The cells on a worksheet that have been selected are a cell ________. 
Answer:  range 
Diff: 2    Page Ref: 337 
Objective:  5. Work with cells and cell ranges 
 
88) ________ combines selected cells into a single cell and then centers the text within that 
single cell. 
Answer:  Merge & Center 
Diff: 1    Page Ref: 343 
Objective:  5. Work with cells and cell ranges 
 
89) Blank areas of a worksheet that do not contain data or documentation are called ________. 
Answer:  white space 
Diff: 2    Page Ref: 345 
Objective:  5. Work with cells and cell ranges 
 
90) ________ is a smart copy that will try to guess how you want values or formulas changed as 
you copy. 
Answer:  AutoFill 
Diff: 2    Page Ref: 354 
Objective:  7. Manipulate worksheets and workbooks 
 
91) When using ________ orientation, the horizontal dimension of the paper is longer. 
Answer:  landscape 
Diff: 3    Page Ref: 366 
Objective:  8. Preview, print, and export workbooks 

92) When using ________ orientation, the vertical dimension of the paper is longer. 
Answer:  portrait 
Diff: 3    Page Ref: 366 
Objective:  8. Preview, print, and export workbooks 
 
93) ________ is a file type that preserves most formatting attributes of a source document 
regardless of the software in which the document was created. 
Answer:  PDF, Portable Document Format 
Diff: 2    Page Ref: 367 
Objective:  8. Preview, print, and export workbooks 
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94) Match the following terms with their definition. 
 
I. Cell 
II. Column  
III. Field  
IV. Formula 
V. Function  
 
A. Performs a mathematical calculation 
B. The intersection of a row and a column in a table or worksheet 
C. A built-in formula 
D. An item of information in a worksheet column that is associated with something of interest 
E. A vertical set of cells that encompasses all the rows in a worksheet 
Answer:  B, E, D, A, C 
Diff: 2    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
 
95) Match the following terms with their definition. 
 
I. Record  
II. Row 
III. Spreadsheet  
IV. What-if analysis  
V. Worksheet 
 
A. A horizontal set of cells that encompasses all the columns in a worksheet 
B. A two-dimensional grid that can be used to model quantitative data 
C. Each instance of a spreadsheet 
D. All of the categories of data that are formatted as a row in a worksheet 
E. Allows you to examine the outcome of the changes to values in a worksheet 
Answer:  D, A, B, E, C 
Diff: 2    Page Ref: 325 
Objective:  1. Understand spreadsheet terminology and components  
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96) Match the following terms with their definition. 
 
I. Active worksheet  
II. Workbook  
III. Active cell  
IV. Cell reference  
V. Keyboard shortcut  
 
A. An Excel file that contains one or more worksheets 
B. Identified by the thick green border 
C. Has a white background with bold letters and a thick bottom border 
D. Eliminates the need to use a mouse 
E. A reference within a formula or function instead of a value 
Answer:  C, A, B, E, D 
Diff: 3    Page Ref: 326-329 
Objective:  Various 
 
97) Match the following terms with their definition. 
 
I. Comment  
II. Date data  
III. Numeric data  
IV. Text data  
V. Time data  
 
A. A text box, similar to a sticky note, that is attached to a cell 
B. Can contain any combination of printable characters  
C. Data that contains only the digits 0-9 and possibly a period (.) 
D. Represented as a decimal value 
E. Takes the form of a serial number 
Answer:  A, E, C, B, D 
Diff: 2    Page Ref: 332-334 
Objective:  Various 
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98) Match the following terms with their definition. 
 
I. Cell range  
II. Clipboard  
III. Contiguous cell range  
IV. Destination cell  
V. Noncontiguous cell range 
 
A. The cells in the worksheet that have been selected 
B. A range consisting of multiple selected cells, all of which are directly adjacent to at least one 
other 
C. A range consisting of multiple selected cells, at least one of which is not directly adjacent to 
at least one other 
D. The cell that receives the result of an operation 
E. A temporary storage location 
Answer:  A, E, B, D, C 
Diff: 2    Page Ref: 337 
Objective:  5. Work with cells and cell ranges 

99) Match the following terms with their definition. 
 
I. Normal view  
II. Page Break Preview  
III. Print Preview  
IV. Page Layout view  
V. Orientation 
 
A. Only the cells in the worksheet are visible 
B. Does not show page margins, headers, or footers 
C. The Backstage View of a workbook 
D. Shows page margins, print headers and footers, and page breaks 
E.  Layout of how the workbook will print on paper 
Answer:  A, B, C, D, E 
Diff: 2    Page Ref: 358-366 
Objective:  5. Work with cells and cell ranges 
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Your Office: Microsoft Office 2016 Volume 1 (Kinser) 

PowerPoint Chapter 1 

 

1) Which of the following is NOT a question that you need to consider when determining your 

target audience? 

A) How large is the audience? 

B) How long are you expected to speak? 

C) Why is the topic important to your audience? 

D) What should you say about the history of your company? 

Answer:  D 

Diff: 3    Page Ref: 765 

Objective:  1. Plan your presentation with a purpose for an intended outcome 

 

2) For the most part, the purpose of presentations will fall into one of ________ categories? 

A) two 

B) three 

C) four 

D) five 

Answer:  B 

Diff: 2    Page Ref: 765 

Objective:  1. Plan your presentation with a purpose for an intended outcome 

 

3) Regarding the purpose of presentations, all of the following are one of the categories 

EXCEPT: 

A) Storytelling 

B) Informational 

C) Persuasion 

D) Prepare 

Answer:  A 

Diff: 2    Page Ref: 765-766 

Objective:  1. Plan your presentation with a purpose for an intended outcome 

 

4) For each hour of a presentation, you allow ________ hours of planning time. 

A) two 

B) three 

C) four 

D) five 

Answer:  C 

Diff: 2    Page Ref: 766 

Objective:  2. Define the purpose, scope, and audience of a presentation 
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5) All of the following are storyboard panels EXCEPT: 

A) layout. 

B) content. 

C) timing considerations. 

D) audio/visual elements. 

Answer:  C 

Diff: 2    Page Ref: 770 

Objective:  3. Plan the presentation content 

6) A ________ is a conceptual drawing, much like a comic book. 

A) template 

B) design theme 

C) storyboard 

D) Pecha Kucha 

Answer:  C 

Diff: 2    Page Ref: 770 

Objective:  3. Plan the presentation content 

 

7) In a presentation, which type of chart would be used to show a comparison of the parts to the 

whole? 

A) Column 

B) Line 

C) Bar 

D) Pie 

Answer:  D 

Diff: 1    Page Ref: 771 

Objective:  3. Plan the presentation content 

 

8) In a presentation, which type chart would be used to show trends over time? 

A) Column 

B) Line 

C) Bar 

D) Pie 

Answer:  B 

Diff: 1    Page Ref: 771 

Objective:  3. Plan the presentation content 

 

9) Which of the following is NOT a citation formatting source suggested in the text? 

A) Chicago Manual of Style 

B) Modern Language Association 

C) Council of Science Editors 

D) American Psychological Association 

Answer:  C 

Diff: 2    Page Ref: 772 

Objective:  3. Plan the presentation content 
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10) PowerPoint's default view is the ________ view. 

A) Slide Show 

B) Notes 

C) Normal 

D) Outline 

Answer:  C 

Diff: 2    Page Ref: 772 

Objective:  4. Work with PowerPoint windows and views 

11) When beginning to create a presentation, it is suggested that you use the ________ view. 

A) Outline 

B) Normal 

C) Notes 

D) Slide Show 

Answer:  A 

Diff: 2    Page Ref: 772-773 

Objective:  4. Work with PowerPoint windows and views 

 

12) Which of the follow in NOT a Normal view pane? 

A) Right hand 

B) Left hand 

C) Slide 

D) Notes 

Answer:  A 

Diff: 3    Page Ref: 773 

Objective:  4. Work with PowerPoint windows and views 

 

13) The ________ pane is used to edit text, images, and other slide objects. 

A) Notes 

B) Picture 

C) Slide 

D) Edit 

Answer:  C 

Diff: 2    Page Ref: 773 

Objective:  4. Work with PowerPoint windows and views 

 

14) The Zoom Slider is located on the ________. 

A) Left pane 

B) Status bar 

C) Notes pane 

D) Slide pane 

Answer:  B 

Diff: 2    Page Ref: 773 

Objective:  4. Work with PowerPoint windows and views 
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15) You would use ________ view to rearrange slides and review slide transitions. 

A) Slide Sorter 

B) Slide Show 

C) Normal 

D) Outline 

Answer:  A 

Diff: 2    Page Ref: 775 

Objective:  4. Work with PowerPoint windows and views 

16) When using Slide Sorter view, the selected slide is highlighted by ________. 

A) red circles at each corner 

B) an orange border 

C) a red border 

D) orange circles at each corner 

Answer:  B 

Diff: 2    Page Ref: 775 

Objective:  4. Work with PowerPoint windows and views 

 

17) Which of the following is NOT a view button on the status bar? 

A) Notes Page 

B) Slide Sorter 

C) Slide Show 

D) Reading 

Answer:  A 

Diff: 2    Page Ref: 775 

Objective:  4. Work with PowerPoint windows and views 

 

18) You can change the screen size by clicking Slide Size on the ________ tab. 

A) Home 

B) Slide Show 

C) View 

D) Design 

Answer:  D 

Diff: 2    Page Ref: 778 

Objective:  4. Work with PowerPoint windows and views 

 

19) Which of the following is NOT a method of advancing to the next slide during a 

presentation? 

A) Using a mouse 

B) Using voice control 

C) Using the keyboard 

D) Swiping on a touch screen 

Answer:  B 

Diff: 2    Page Ref: 780 

Objective:  5. Navigate in Slide Show view and Outline View 
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20) During a presentation, pressing ________ will advance to the next slide. 

A) Esc 

B) Ctrl 

C) Spacebar 

D) Alt 

Answer:  C 

Diff: 2    Page Ref: 780 

Objective:  5. Navigate in Slide Show view and Outline View 

21) During a presentation, pressing ________ will advance to the next slide. 

A) Back arrow 

B) Down arrow 

C) F5 

D) F6 

Answer:  B 

Diff: 2    Page Ref: 780 

Objective:  5. Navigate in Slide Show view and Outline View 

 

22) To end a slide show, press ________. 

A) Down arrow 

B) F3 

C) F5 

D) Esc 

Answer:  D 

Diff: 2    Page Ref: 780 

Objective:  5. Navigate in Slide Show view and Outline View 

 

23) When running a slide show, which of the following is NOT a key that returns to the previous 

slide? 

A) PgDn 

B) Backspace 

C) P 

D) Up arrow 

Answer:  A 

Diff: 2    Page Ref: 780 

Objective:  5. Navigate in Slide Show view and Outline View 

 

24) When viewing a slide show, which of the following is NOT a key that advances to the next 

slide? 

A) G 

B) PgDn 

C) Enter 

D) Down arrow 

Answer:  A 

Diff: 2    Page Ref: 780 

Objective:  5. Navigate in Slide Show view and Outline View 
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25) When viewing a slide show, pressing ________ will display all slides. 

A) D 

B) F3 

C) G 

D) F6 

Answer:  C 

Diff: 1    Page Ref: 780 

Objective:  5. Navigate in Slide Show view and Outline View 

26)  Some presenters use the ________ rule to help guide the amount of text placed on a slide. 

A) no more than nine 

B) 9 x 9 

C) 6 x 6 

D) no more than six 

Answer:  C 

Diff: 2    Page Ref: 782 

Objective:  5. Navigate in Slide Show view and Outline View 

 

27) To add a new slide, click the New Slide button in the ________ tab. 

A) Slides group on the Home 

B) Slides group on the Design 

C) Customize group on the Home 

D) Customize group on the Design 

Answer:  A 

Diff: 2    Page Ref: 783 

Objective:  6. Add, reuse, and rearrange slides and change slide layouts 

 

28) When planning a presentation, you should plan to show a new slide every ________ 

minute(s). 

A) one 

B) two to three 

C) one to two 

D) two 

Answer:  B 

Diff: 2    Page Ref: 784 

Objective:  6. Add, reuse, and rearrange slides and change slide layouts 

 

29) PowerPoint objects that hold different types of content for the presentation are called 

________. 

A) containers 

B) placeholders 

C) capsules 

D) receptacles 

Answer:  B 

Diff: 2    Page Ref: 786 

Objective:  6. Add, reuse, and rearrange slides and change slide layouts 
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30) Sizing handles are small ________ in the center and corners of the border surrounding an 

object that can be used to resize the object. 

A) squares or diamonds 

B) squares or triangles 

C) boxes or circles 

D) boxes or triangles 

Answer:  C 

Diff: 2    Page Ref: 786 

Objective:  6. Add, reuse, and rearrange slides and change slide layouts 

31) Background, color, and font selections are included as part of a(n) ________. 

A) storyboard 

B) slide layout 

C) design theme 

D) placeholder 

Answer:  C 

Diff: 2    Page Ref: 787 

Objective:  7. Understand the purpose and benefits of using themes 

 

32) The Header & Footer button is located in the ________ tab. 

A) Comments group on the Insert tab 

B) Comments group on the Design tab 

C) Text group on the Insert tab 

D) Text group on the Design tab 

Answer:  C 

Diff: 1    Page Ref: 791 

Objective:  7. Understand the purpose and benefits of using themes 

 

33) ________ space is a space on a slide without text or graphics. 

A) Blue 

B) Clear 

C) White 

D) Green 

Answer:  C 

Diff: 1    Page Ref: 794 

Objective:  8. Edit and move slide content 

 

34) The ________ tool gives access to a variety of reference books, dictionaries, research 

websites, and business and financial sites. 

A) Smart Lookup 

B) Spelling 

C) Thesaurus 

D) Research 

Answer:  A 

Diff: 2    Page Ref: 795 

Objective:  9. Utilize proofing and research tools 
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35) The ________ tool is a research tool that enables you to select synonyms for words in the 

presentation. 

A) Smart Lookup 

B) Spelling 

C) Thesaurus 

D) Research 

Answer:  C 

Diff: 2    Page Ref: 795 

Objective:  9. Utilize proofing and research tools 

36) Saving a presentation ________ allows you to open the presentation without having to open 

PowerPoint. 

A) as a storyboard 

B) as a PDF file 

C) in Slide Show view 

D) as a PowerPoint Show 

Answer:  D 

Diff: 2    Page Ref: 798 

Objective:  10. Save a presentation 

 

37) Saving a presentation ________ allows you to easily distribute the presentation on a website. 

A) as a storyboard 

B) as a PDF file 

C) in Slide Show view 

D) as a PowerPoint Show 

Answer:  B 

Diff: 2    Page Ref: 799 

Objective:  10. Save a presentation 

 

38) A PowerPoint file that includes predefined layouts, theme colors, and fonts is called a 

________. 

A) placeholder 

B) template 

C) theme 

D) smart layout 

Answer:  B 

Diff: 3    Page Ref: 802 

Objective:  12. Utilize PowerPoint templates to create presentations 

 

39) Adding visual components helps make a presentation memorable. 

Answer:  TRUE 

Diff: 1    Page Ref: 765 

Objective:  1. Plan your presentation with a purpose for an intended outcome 
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40) PowerPoint 2016 is an application that enables users to create professional-quality 

presentations. 

Answer:  TRUE 

Diff: 1    Page Ref: 765 

Objective:  1. Plan your presentation with a purpose for an intended outcome 

 

41) An individual data value is a data series. 

Answer:  FALSE 

Diff: 1    Page Ref: 485 

Objective:  1. Plan your presentation with a purpose for an intended outcome 

 

42) Generally, the purpose of presentations will fall into one of four major categories. 

Answer:  FALSE 

Diff: 2    Page Ref: 765 

Objective:  1. Plan your presentation with a purpose for an intended outcome 

43) An example of a presentation used to prepare the audience is a museum kiosk that provides 

history of the artwork. 

Answer:  FALSE 

Diff: 3    Page Ref: 765 

Objective:  1. Plan your presentation with a purpose for an intended outcome 

 

44) An example of a presentation used to inform an audience is a class lecture. 

Answer:  TRUE 

Diff: 3    Page Ref: 765 

Objective:  1. Plan your presentation with a purpose for an intended outcome 

 

45) Sales and political presentations are examples of informational presentations. 

Answer:  FALSE 

Diff: 3    Page Ref: 766 

Objective:  1. Plan your presentation with a purpose for an intended outcome 

 

46) Click outside a chart object or press Esc to deselect an object. 

Answer:  TRUE 

Diff: 2    Page Ref: 487 

Objective:  1. Plan your presentation with a purpose for an intended outcome 

 

47) According to Cliff Atkinson, you should write a script for your presentation that makes the 

audience the protagonist, or the main character, who faces a problem that you will help to solve. 

Answer:  TRUE 

Diff: 3    Page Ref: 766 

Objective:  1. Plan your presentation with a purpose for an intended outcome 
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48) A good presenter will allow approximately two hours of planning time for each hour of 

presentation time. 

Answer:  FALSE 

Diff: 2    Page Ref: 766 

Objective:  2. Define the purpose, scope, and audience of a presentation 

 

49) Pecha Kucha is Japanese for chit-chat. 

Answer:  TRUE 

Diff: 2    Page Ref: 768 

Objective:  2. Define the purpose, scope, and audience of a presentation 

 

50) Using a storyboard can enable you to plan and visualize how your presentation will come 

together. 

Answer:  TRUE 

Diff: 2    Page Ref: 770 

Objective:  3. Plan the presentation content 

 

51) Storyboards were developed by Pixar during the 1980s. 

Answer:  FALSE 

Diff: 3    Page Ref: 770 

Objective:  3. Plan the presentation content 

52) A line chart is used to display a part to a whole. 

Answer:  FALSE 

Diff: 1    Page Ref: 771 

Objective:  3. Plan the presentation content 

 

53) A pie chart shows trends over time. 

Answer:  FALSE 

Diff: 1    Page Ref: 771 

Objective:  3. Plan the presentation content 

 

54) Bar charts are similar to column charts. 

Answer:  TRUE 

Diff: 1    Page Ref: 771 

Objective:  3. Plan the presentation content 

 

55) Outline view is the default view in PowerPoint. 

Answer:  FALSE 

Diff: 2    Page Ref: 772 

Objective:  4. Work with PowerPoint windows and views 

 

56) Normal view is used to edit the slides. 

Answer:  TRUE 

Diff: 2    Page Ref: 775 

Objective:  4. Work with PowerPoint windows and views 
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57) Slide Show view is used to display the presentation to an audience. 

Answer:  TRUE 

Diff: 2    Page Ref: 775 

Objective:  4. Work with PowerPoint windows and views 

 

58) In a presentation, Reading View displays the titles and bullet points of the slides. 

Answer:  FALSE 

Diff: 2    Page Ref: 780 

Objective:  5. Navigate in Slide Show view and Outline View 

 

59) Demoting outline text moves the text up a level, and promoting outline text moves the text 

down a level. 

Answer:  FALSE 

Diff: 1    Page Ref: 780 

Objective:  5. Navigate in Slide Show view and Outline View 

 

60) To be a good communicator you need to be a good storyteller. 

Answer:  TRUE 

Diff: 2    Page Ref: 782 

Objective:  6. Add, reuse, and rearrange slides and change slide layouts 

 

61) You should always include contact information at the end of your presentation. 

Answer:  TRUE 

Diff: 2    Page Ref: 783 

Objective:  6. Add, reuse, and rearrange slides and change slide layouts 

62) Design themes are available on the Home tab in PowerPoint. 

Answer:  FALSE 

Diff: 2    Page Ref: 788 

Objective:  7. Understand the purpose and benefits of using themes 

 

63) White space was named because it refers to the area on a slide that is actually white in color. 

Answer:  FALSE 

Diff: 2    Page Ref: 794 

Objective:  7. Understand the purpose and benefits of using themes 

 

64) The ________ audience refers to the general characteristics of the group of people to whom 

you are planning to present. 

Answer:  target 

Diff: 2    Page Ref: 765 

Objective:  1. Plan your presentation with a purpose for an intended outcome 

 

65) Every presentation begins with ________. 

Answer:  planning 

Diff: 3    Page Ref: 766 

Objective:  2. Define the purpose, scope, and audience of a presentation 
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66) The unique format for presentations that was first used in Tokyo, Japan, in 2003 by a 

Western architecture firm is called ________. 

Answer:  Pecha Kucha 

Diff: 3    Page Ref: 768 

Objective:  2. Define the purpose, scope, and audience of a presentation 

 

67) A good presentation can help to organize the audience's thinking by providing a(n) ________ 

of the presentation. 

Answer:  roadmap 

Diff: 2    Page Ref: 769 

Objective:  2. Define the purpose, scope, and audience of a presentation 

 

68) A(n) ________ resembles a comic book. 

Answer:  storyboard 

Diff: 2    Page Ref: 770 

Objective:  3. Plan the presentation content 

 

69) The concept of storyboards was developed by ________ during the 1930s. 

Answer:  Walt Disney Studio 

Diff: 3    Page Ref: 770 

Objective:  3. Plan the presentation content 

 

70) Storyboards date back to the ________. 

Answer:  1930s 

Diff: 2    Page Ref: 770 

Objective:  3. Plan the presentation content 

 

71) A(n) ________ chart is used to display the parts of a whole. 

Answer:  pie 

Diff: 1    Page Ref: 771 

Objective:  3. Plan the presentation content 

72) A(n) ________ or column chart is used to compare items in rank or changes over a period of 

time. 

Answer:  bar 

Diff: 1    Page Ref: 771 

Objective:  3. Plan the presentation content 

 

73) A(n) ________ or column chart is used to show changes over time. 

Answer:  line 

Diff: 1    Page Ref: 771 

Objective:  3. Plan the presentation content 

 

74) ________ view is the default view in PowerPoint. 

Answer:  Normal 

Diff: 2    Page Ref: 772 

Objective:  4. Work with PowerPoint windows and views 



13 

Copyright © 2017 Pearson Education, Inc. 

 

75) ________ View is a view that presents left pane content on the slide in a text hierarchy that 

allows the presentation creator to focus on the content. 

Answer:  Outline view 

Diff: 2    Page Ref: 772-773 

Objective:  4. Work with PowerPoint windows and views 

 

76) The ________ pane allows the user to select a slide. 

Answer:  left 

Diff: 2    Page Ref: 773 

Objective:  4. Work with PowerPoint windows and views 

 

77) The ________ pane allows the addition of content for the speaker, not visible to the 

audience. 

Answer:  Notes 

Diff: 2    Page Ref: 773 

Objective:  4. Work with PowerPoint windows and views 

 

78) The ________ view displays the slides one at a time, offering tools such as the title bar 

button and navigation buttons for moving between slides. 

Answer:  Reading 

Diff: 3    Page Ref: 775 

Objective:  4. Work with PowerPoint windows and views 

 

79) The ________ view is used to display the presentation to an audience. 

Answer:  Slide Show 

Diff: 3    Page Ref: 775 

Objective:  4. Work with PowerPoint windows and views 

 

80) The ________ view provides options for rearranging slides and reviewing slide transitions. 

Answer:  Slide Sorter 

Diff: 2    Page Ref: 775 

Objective:  4. Work with PowerPoint windows and views 

 

81) When a slide is selected in Slide Sorter view, it is highlighted with a(n) ________ border. 

Answer:  orange 

Diff: 2    Page Ref: 775 

Objective:  4. Work with PowerPoint windows and views 

82) To exit a presentation while it is displayed in Slide Show view, press ________. 

Answer:  Esc 

Diff: 1    Page Ref: 778 

Objective:  5. Navigate in Slide Show view and Outline View 
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83) Some presenters follow the ________ rule when determining how much text to include on a 

slide. 

Answer:  6 x 6 

Diff: 2    Page Ref: 782 

Objective:  5. Navigate in Slide Show view and Outline View 

 

84) To resize a placeholder on a slide, click and drag a(n) ________. 

Answer:  sizing handle 

Diff: 2    Page Ref: 786 

Objective:  6. Add, reuse, and rearrange slides and change slide layouts 

 

85) The slide ________ are provided as part of the theme applied to the presentation. 

Answer:  layouts 

Diff: 2    Page Ref: 786 

Objective:  6. Add, reuse, and rearrange slides and change slide layouts 

 

86) A design ________ add visual interest to a presentation, including background, color, and 

font selections. 

Answer:  theme 

Diff: 1    Page Ref: 787 

Objective:  7. Understand the purpose and benefits of using themes 

 

87) A(n) slide ________ is displayed at the bottom of the slide and can include items such as the 

slide number or date. 

Answer:  footer 

Diff: 1    Page Ref: 791 

Objective:  7. Understand the purpose and benefits of using themes 

 

88) A container where text and graphic elements are placed is called a slide ________. 

Answer:  placeholder 

Diff: 2    Page Ref: 794 

Objective:  8. Edit and move slide content 

 

89) ________ serves as a resting place for the eyes. 

Answer:  White space 

Diff: 2    Page Ref: 794 

Objective:  8. Edit and move slide content 

 

90) The ________ tool provides access to a variety of reference books, dictionaries, research 

websites, and business and financial sites. 

Answer:  Smart Lookup 

Diff: 3    Page Ref: 795 

Objective:  9. Utilize proofing and research tools 
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91) The ________ tool is used to check the spelling of the presentation. 

Answer:  Spelling 

Diff: 1    Page Ref: 795 

Objective:  9. Utilize proofing and research tools 

 

92) The research tool that enables you to select synonyms for words in the presentation is the 

________ tool. 

Answer:  Thesaurus 

Diff: 1    Page Ref: 795 

Objective:  9. Utilize proofing and research tools 

 

93) A(n) ________ is a convenient way to view a presentation because you do not need to open 

PowerPoint. 

Answer:  PowerPoint Show 

Diff: 2    Page Ref: 798 

Objective:  10. Save a presentation 

 

94) When a presentation is saved as a(n) ________ file, it does not open in PowerPoint rather in 

Adobe Reader. 

Answer:  PDF, Portable Document Format 

Diff: 2    Page Ref: 799 

Objective:  11. Preview and print a presentation 

 

95) A PowerPoint file with predefined layouts, theme colors, and fonts is called a(n) ________. 

Answer:  template 

Diff: 1    Page Ref: 802 

Objective:  12. Utilize PowerPoint templates to create presentations 

 

96) Match the following terms with their definition. 

 

I. Slide pane 

II. Left pane 

III. Normal view 

IV. Notes pane 

V. Outline view 

 

A. Allows you to add speaker notes that the audience will not see 

B. Displays one slide at a time allowing the user to add, edit, and format content 

C. Used to place content on the slide in a text hierarchy 

D. The default view of PowerPoint 

E. Pane that allows you to select a slide 

Answer:  B, E, D, A, C 

Diff: 2    Page Ref: 772-773 

Objective:  Various 
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97) Match the following terms with their definition. 

 

I. Target audience 

II. Pecha Kucha 

III. Reading view 

IV. Slide Show view 

V. Slide Sorter view 

 

A.  A format that displays 20 slides for 20 seconds each 

B. Displays the slides one at a time 

C. The group of people for whom you are planning the presentation 

D. Used to display the presentation to an audience 

E. Provides options for rearranging slides and reviewing slide transitions 

Answer:  C, A, B, D, E 

Diff: 3    Page Ref: 765, 768, 775 

Objective:  Various 

 

98) Match the following terms with their description. 

 

 I. Sizing handles 

II. Slide layout 

III. Design theme 

IV. Slide footer 

V. Slide placeholder 

 

A. The placement of objects, such as the title and body content, on the slide 

B.  A set of elements such as colors and fonts that enable you to create consistent slides 

C. A container for text and graphic elements that can be moved and resized 

D. Small boxes or circles in the center and corners of the border surrounding an object 

E. Information that is displayed at the bottom of a slide 

Answer:  D, A, B, E, C 

Diff: 2    Page Ref: 786-794 

Objective:  Various 
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99) Match the following terms with their description. 

 

 I. White space 

II. Smart lookup 

III. Spelling tool 

IV. Thesaurus tool 

V. PowerPoint Show 

 

A. Used to check the spelling of the presentation 

B. A PowerPoint view that opens full screen 

C. A research tool that enables you to select synonyms for words in the presentation 

D. A research tool that provides access to a variety of reference materials 

E. Area that allows the user's eyes to rest 

Answer:  E, D, A, C, B 

Diff: 2    Page Ref: 794-798 

Objective:  Various 
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Your Office: Microsoft Office 2016 Volume 1 (Kinser) 

Word Chapter 1 

 

1) Business communication is also known as a(n) ________. 
A) inherent skill 
B) soft skill 
C) unimportant skill 
D) one-way street 
Answer:  B 
Diff: 1    Page Ref: 127 
Objective:  1. Use word-processing software 
 
2) Which of the following is NOT true about business communication? 
A) Written and verbal communication is a regular part of daily life. 
B) The way that you communicate gives others a first and lasting impression of you. 
C) Annually, American businesses spend $5.2 billion on communication training. 
D) Students often spend too little time developing communication skills. 
Answer:  C 
Diff: 3    Page Ref: 127 
Objective:  1. Use word-processing software 
 
3) Microsoft's most current version of its word-processing software is Microsoft Word 
________. 
A) 2010 
B) 2011 
C) 2013 
D) 2016 
Answer:  D 
Diff: 2    Page Ref: 127 
Objective:  1. Use word-processing software 
 
4) Microsoft Word 2016 can be used to create all of the following EXCEPT: 
A) presentations. 
B) reports. 
C) letters. 
D) business cards. 
Answer:  A 
Diff: 1    Page Ref: 127 
Objective:  1. Use word-processing software 
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5) The Word ________ screen displays when Microsoft Word 2016 is opened. 
A) Open 
B) Beginning 
C) Start 
D) Navigation 
Answer:  C 
Diff: 2    Page Ref: 127 
Objective:  1. Use word-processing software 

6) In Microsoft Word 2016, all of the following display on the Word Start screen EXCEPT: 
A) a list of recent documents. 
B) an option to open other documents from OneDrive, your hard drive, or other web locations. 
C) an option to create a new document from templates. 
D) the Backstage view. 
Answer:  D 
Diff: 2    Page Ref: 127 
Objective:  1. Use word-processing software 
 
7) With written communication, it may be difficult for a reader to understand the author's tone 
because of the absence of ________. 
A) knowing who the target audience is 
B) body language 
C) your true feelings 
D) your areas of expertise 
Answer:  B 
Diff: 2    Page Ref: 130 
Objective:  2. Develop effective business documents 
 
8) In written communication, ________ should be avoided because the message can come across 
the wrong way. 
A) using an active voice 
B) humor 
C) exclamation points 
D) all lowercase letters 
Answer:  B 
Diff: 2    Page Ref: 131 
Objective:  2. Develop effective business documents 
 
9) All of the following are examples of internal communication EXCEPT: 
A) memos 
B) in-house newsletters 
C) email 
D) brochures 
Answer:  D 
Diff: 2    Page Ref: 131 
Objective:  3. Work with business correspondence 
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10) All of the following are examples of external communication EXCEPT: 
A) brochures 
B) memos 
C) reports 
D) letters 
Answer:  B 
Diff: 2    Page Ref: 131 
Objective:  3. Work with business correspondence 

11) The main difference between a(n) ________ and a letter is the target audience. 
A) brochure 
B) in-house newsletter 
C) newsletter 
D) memo 
Answer:  D 
Diff: 2    Page Ref: 131 
Objective:  3. Work with business correspondence 
 
12) The ________ letter style is when the entire letter is left-aligned and single-spaced except for 
double spacing between paragraphs. 
A) block 
B) modified block 
C) semi-block 
D) signature block 
Answer:  A 
Diff: 2    Page Ref: 133 
Objective:  3. Work with business correspondence 
 
13) In a business letter, the ________ directly addresses the recipient. 
A) inside address 
B) salutation 
C) reference 
D) heading 
Answer:  B 
Diff: 2    Page Ref: 133 
Objective:  3. Work with business correspondence 
 
14) In a business letter, the ________ includes the date of the letter. 
A) inside address 
B) salutation 
C) reference 
D) heading 
Answer:  D 
Diff: 2    Page Ref: 133 
Objective:  3. Work with business correspondence 
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15) In a business letter, the ________ includes the message area. 
A) body 
B) complementary close 
C) signature block 
D) end notation 
Answer:  A 
Diff: 2    Page Ref: 133 
Objective:  3. Work with business correspondence 

16) In a business letter, abbreviations that have important functions such as Encl are included as 
a(n) ________. 
A) heading 
B) complementary close 
C) signature block 
D) end notation 
Answer:  D 
Diff: 2    Page Ref: 133 
Objective:  3. Work with business correspondence 
 
17) ________ in Microsoft Word 2016 provides an interactive screen-reading experience. 
A) Print Layout 
B) Outline view 
C) Read Mode 
D) Draft view 
Answer:  C 
Diff: 2    Page Ref: 135 
Objective:  4. Explore the Word interface 
 
18) ________ in Microsoft Word 2016 shows the structure of a document in a hierarchical 
fashion. 
A) Print Layout 
B) Outline view 
C) Read Mode 
D) Draft view 
Answer:  B 
Diff: 2    Page Ref: 135 
Objective:  4. Explore the Word interface 
 
19) The ________ key will reposition the insertion point at the beginning of the document. 
A) Ctrl+Home 
B) Home 
C) PgDn 
D) PgUp 
Answer:  A 
Diff: 2    Page Ref: 138 
Objective:  5. Insert and delete text 
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20) The ________ key will reposition the insertion point at the end of the line. 
A) Ctrl+PgDn 
B) End 
C) PgDn 
D) Ctrl+End 
Answer:  B 
Diff: 2    Page Ref: 138 
Objective:  5. Insert and delete text 

21) In Microsoft Word 2016, text can be deleted by using all of the following options EXCEPT: 
A) pressing Backspace. 
B) pressing Delete. 
C) clicking Undo on the Quick Access Toolbar. 
D) pressing Ctrl+Delete. 
Answer:  D 
Diff: 1    Page Ref: 138 
Objective:  5. Insert and delete text 
 
22) Many character formats in Microsoft Word 2016 can be found on the ________ tab. 
A) View 
B) Home 
C) Insert 
D) Format 
Answer:  B 
Diff: 2    Page Ref: 140 
Objective:  6. Format characters 
 
23) To select an entire paragraph in a Microsoft Word 2016 document, ________ the paragraph. 
A) single-click 
B) double-click 
C) triple-click 
D) point to 
Answer:  C 
Diff: 2    Page Ref: 141 
Objective:  6. Format characters 
 
24) To select one word in a Microsoft Word 2016 document, ________ the word. 
A) single-click 
B) double-click 
C) triple-click 
D) point to 
Answer:  B 
Diff: 2    Page Ref: 141 
Objective:  6. Format characters 
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25) To select everything in a Microsoft Word 2016 document, press ________. 
A) Ctrl+A 
B) Shift+A 
C) Ctrl+Shift+A 
D) Enter+A 
Answer:  A 
Diff: 2    Page Ref: 141 
Objective:  6. Format characters 

26) A typical font size for the body of a document is ________. 
A) 8-pt 
B) 9-pt or 10-pt 
C) 11-pt or 12-pt 
D) 13-pt 
Answer:  C 
Diff: 3    Page Ref: 143 
Objective:  6. Format characters 
 
27) A paragraph in a Microsoft Word 2016 document is identified by a(n) ________. 
A) tab 
B) indent 
C) soft return 
D) hard return 
Answer:  D 
Diff: 2    Page Ref: 146 
Objective:  7. Format paragraphs 
 
28) By default, paragraphs in a Microsoft Word 2016 document are ________. 
A) left-aligned 
B) right-aligned 
C) justified 
D) centered 
Answer:  A 
Diff: 2    Page Ref: 146 
Objective:  7. Format paragraphs 
 
29) The default paragraph spacing in a new, blank Microsoft Word 2016 document is ________ 
pt. 
A) 0 
B) 6 
C) 8 
D) 12 
Answer:  C 
Diff: 3    Page Ref: 147 
Objective:  7. Format paragraphs 
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30) The ________ paragraph line spacing setting in a Microsoft Word 2016 document enables 
you to set line spacing at an interval other than pre-programmed line spacing settings such as 
single. 
A) At Least 
B) Multiple 
C) Exactly 
D) Double 
Answer:  B 
Diff: 2    Page Ref: 149 
Objective:  7. Format paragraphs 

31) The ________ paragraph line spacing setting in a Microsoft Word 2016 document is more 
commonly used in desktop publishing. 
A) At Least 
B) Multiple 
C) Exactly 
D) Double 
Answer:  A 
Diff: 2    Page Ref: 149 
Objective:  7. Format paragraphs 
 
32) Word automatically checks spelling as you type and underlines words in ________ that are 
not found in Word's dictionary. 
A) black 
B) green 
C) blue 
D) red 
Answer:  D 
Diff: 1    Page Ref: 150 
Objective:  8. Proofread a document 
 
33) The feature in Word that automatically corrects common typing mistakes as they occur is 
called ________. 
A) SpellCheck 
B) AutoCorrect 
C) Find and Replace 
D) Proofing 
Answer:  B 
Diff: 2    Page Ref: 151 
Objective:  8. Proofread a document 
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34) The ________ feature in Word can be used to correct mistakes that appear repeatedly 
throughout a document. 
A) SpellCheck 
B) AutoCorrect 
C) Find and Replace 
D) Proofing 
Answer:  C 
Diff: 2    Page Ref: 153 
Objective:  8. Proofread a document 
 
35) The ________ Pane in Word provides a set of related features for moving through a 
document and searching for content. 
A) Document 
B) Replace 
C) Task 
D) Navigation 
Answer:  D 
Diff: 2    Page Ref: 153 
Objective:  8. Proofread a document 

36) The ________ wildcard is used to represent any number of characters, including none. 
A) * 
B) # 
C) % 
D) ? 
Answer:  A 
Diff: 2    Page Ref: 154 
Objective:  8. Proofread a document 
 
37) Which of the following is NOT true about headers and footers? 
A) A header or footer consists of one or more lines of text or graphics printed in the top or 
bottom margin of a document. 
B) By default, a footer is included in a document. 
C) A header appears in the top margin; a footer appears in the bottom margin. 
D) The most commonly used footer is a page number. 
Answer:  B 
Diff: 3    Page Ref: 156 
Objective:  9. Insert a header and a footer 
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38) The ________ button in Word 2016 enables you to quickly add some of the more common 
fields in a header and footer. 
A) Quick Edit 
B) Insert Field 
C) Document Info 
D) Header/Footer 
Answer:  C 
Diff: 3    Page Ref: 157 
Objective:  9. Insert a header and a footer 
 
39) By default, Word 2016 saves files in a ________ format. 
A) .pdf 
B) .txt 
C) .docx 
D) .doc 
Answer:  C 
Diff: 1    Page Ref: 159 
Objective:  10. Save and close a document, and print a document 
 
40)  By saving a file in a ________ format, you preserve the appearance of your document. 
A) .pdf 
B) .txt 
C) .docx 
D) .doc 
Answer:  A 
Diff: 2    Page Ref: 159 
Objective:  10. Save and close a document, and print a document 
 
41) Communication between members of an organization to carry out business activities is 
referred to as a monologue. 
Answer:  FALSE 
Diff: 2    Page Ref: 127 
Objective:  1. Use word-processing software 

42) Word processing is often cited as one of the main reasons to use a computer. 
Answer:  TRUE 
Diff: 1    Page Ref: 127 
Objective:  1. Use word-processing software 
 
43) Microsoft Word 2016 is Microsoft's most current version of its word-processing software. 
Answer:  TRUE 
Diff: 1    Page Ref: 127 
Objective:  1. Use word-processing software 
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44) You should consider airing your frustration and anger in written communication so you have 
a record of it. 
Answer:  FALSE 
Diff: 2    Page Ref: 131 
Objective:  2. Develop effective business documents 
 
45) Memos, in-house newsletters, and email are examples of external communication. 
Answer:  FALSE 
Diff: 2    Page Ref: 131 
Objective:  3. Work with business correspondence 
 
46) The Semi-block letter style left-aligns the entire letter. 
Answer:  FALSE 
Diff: 2    Page Ref: 133 
Objective:  3. Work with business correspondence 
 
47) The Modified block letter style left-aligns and single-spaces the body of the letter except for 
double spacing between paragraphs. 
Answer:  TRUE 
Diff: 2    Page Ref: 133 
Objective:  3. Work with business correspondence 
 
48) KeyTips allow you to access ribbon commands without taking your hands off the keyboard. 
Answer:  TRUE 
Diff: 2    Page Ref: 134 
Objective:  3. Work with business correspondence 
 
49) Word wrap is a feature that inserts a hard return. 
Answer:  FALSE 
Diff: 2    Page Ref: 135 
Objective:  4. Explore the Word interface 
 
50) Pressing Enter inserts a soft return. 
Answer:  FALSE 
Diff: 2    Page Ref: 135 
Objective:  4. Explore the Word interface 
 
51) The Spacebar, Enter, and Tab keys insert nonprinting characters. 
Answer:  TRUE 
Diff: 2    Page Ref: 135 
Objective:  4. Explore the Word interface 

52) Nonprinting characters are sometimes called formatting marks. 
Answer:  TRUE 
Diff: 2    Page Ref: 135 
Objective:  4. Explore the Word interface 
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53) The blinking black bar that shows where text will be placed is called the insertion point. 
Answer:  TRUE 
Diff: 2    Page Ref: 137 
Objective:  5. Insert and delete text 
 
54) Times New Roman is a sans serif font. 
Answer:  FALSE 
Diff: 2    Page Ref: 142 
Objective:  6. Format characters 
 
55) Serif fonts contain small, thin lines, or hooks, that end the main stroke of each letter. 
Answer:  TRUE 
Diff: 2    Page Ref: 142 
Objective:  6. Format characters 
 
56) Font spacing is either monospaced or proportional. 
Answer:  TRUE 
Diff: 2    Page Ref: 142 
Objective:  6. Format characters 
 
57) The default paragraph alignment in Word 2016 is justified. 
Answer:  FALSE 
Diff: 2    Page Ref: 146 
Objective:  7. Format paragraphs 
 
58) Right-aligned text is often used for short lines such as dates, figure captions, and headers. 
Answer:  TRUE 
Diff: 1    Page Ref: 146 
Objective:  7. Format paragraphs 
 
59) Paragraph spacing refers to the line spacing within a paragraph. 
Answer:  FALSE 
Diff: 1    Page Ref: 147 
Objective:  7. Format paragraphs 
 
60) By default, Word 2016 checks spelling as you type. 
Answer:  TRUE 
Diff: 1    Page Ref: 150 
Objective:  8. Proofread a document 
 
61) The Task Pane is displayed to the left of an open document. 
Answer:  FALSE 
Diff: 2    Page Ref: 153 
Objective:  8. Proofread a document 
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62) Wildcard symbols substitute for characters or numbers. 
Answer:  TRUE 
Diff: 2    Page Ref: 154 
Objective:  8. Proofread a document 
 
63) A page number is the most commonly used footer. 
Answer:  TRUE 
Diff: 2    Page Ref: 156 
Objective:  9. Insert a header and a footer 
 
64) Microsoft Word is the software that can be used to read and print a PDF. 
Answer:  FALSE 
Diff: 2    Page Ref: 159 
Objective:  10. Save and close a document, and print a document 
 
65) Backstage view is where printing and previewing commands can be found. 
Answer:  TRUE 
Diff: 2    Page Ref: 162 
Objective:  10. Save and close a document, and print a document 
 
66) The Word ________ screen displays when you first open Microsoft Word 2016. 
Answer:  Start 
Diff: 2    Page Ref: 127 
Objective:  1. Use word-processing software 
 
67) The ________ letter style is identical to modified block style except that each body 
paragraph is indented 1/2 inch. 
Answer:  Semi-block 
Diff: 3    Page Ref: 133 
Objective:  3. Work with business correspondence 
 
68) The ________ letter style formats the date and closing as left-aligned slightly to the right of 
center. 
Answer:  Modified block 
Diff: 3    Page Ref: 133 
Objective:  3. Work with business correspondence 
 
69) The ________ letter style formats the entire letter as left-aligned and single-spaced except 
for double spacing between paragraphs. 
Answer:  Block 
Diff: 3    Page Ref: 133 
Objective:  3. Work with business correspondence 
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70) Pressing Alt will allow you to access ________, ribbon commands that can be used without 
taking your hands off the keyboard. 
Answer:  KeyTips 
Diff: 2    Page Ref: 134 
Objective:  3. Work with business correspondence 

71) ________ view shows the structure of a document in a hierarchical fashion. 
Answer:  Outline 
Diff: 3    Page Ref: 135 
Objective:  4. Explore the Word interface 
 
72) ________ view is used to edit and format in a text-only environment. 
Answer:  Draft 
Diff: 3    Page Ref: 135 
Objective:  4. Explore the Word interface 
 
73) ________ Mode lets you zoom in and out of graphical objects, translate words, and search on 
Bing. 
Answer:  Read 
Diff: 3    Page Ref: 135 
Objective:  4. Explore the Word interface 
 
74) The ________ feature allows you to continue to type without pressing Enter. 
Answer:  WordWrap 
Diff: 2    Page Ref: 135 
Objective:  4. Explore the Word interface 
 
75) Keys such as Backspace and Tab insert ________ characters in a document. 
Answer:  nonprinting 
Diff: 2    Page Ref: 135 
Objective:  4. Explore the Word interface 
 
76) ________ marks do not show when a document is printed. 
Answer:  Formatting 
Diff: 2    Page Ref: 135 
Objective:  4. Explore the Word interface 
 
77) By default, text is inserted at the ________, within the existing text. 
Answer:  insertion point 
Diff: 2    Page Ref: 137 
Objective:  5. Insert and delete text 
 
78) The location in Word that contains a collection of common actions and settings that apply to 
the current document is called ________ view. 
Answer:  Backstage 
Diff: 3    Page Ref: 139 
Objective:  5. Insert and delete text 
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79) The ________ feature allows you to see changes before they are made to the selected text. 
Answer:  Live Preview 
Diff: 3    Page Ref: 142 
Objective:  6. Format characters 
 
80) The Bodoni and Century Schoolbook typefaces are examples of ________ fonts. 
Answer:  serif 
Diff: 2    Page Ref: 142 
Objective:  6. Format characters 

81) The Arial, Helvetica, and Verdana typefaces are examples of ________ fonts. 
Answer:  sans serif 
Diff: 2    Page Ref: 142 
Objective:  6. Format characters 
 
82) When each character requires the same amount of space, the font's spacing is said to be 
________. 
Answer:  monospaced 
Diff: 3    Page Ref: 142-143 
Objective:  6. Format characters 
 
83) When each character requires only the space that is necessary for display, the font's spacing 
is said to be ________. 
Answer:  proportional 
Diff: 3    Page Ref: 142-143 
Objective:  6. Format characters 
 
84) ________ is an alignment style that spreads text evenly between the right and left margins so 
that lines begin on the left margin and end uniformly on the right margin. 
Answer:  Justified 
Diff: 1    Page Ref: 146 
Objective:  7. Format paragraphs 
 
85) ________ text is often used for short lines such as dates, figure captions, and headers. 
Answer:  Right-aligned 
Diff: 2    Page Ref: 146 
Objective:  7. Format paragraphs 
 
86) ________ text is the primary form of alignment of paragraphs in letters, reports, and memos. 
Answer:  Left-aligned 
Diff: 2    Page Ref: 146 
Objective:  7. Format paragraphs 
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87) Text that is ________ places the middle of each line evenly between the left and right 
margins. 
Answer:  centered 
Diff: 1    Page Ref: 146 
Objective:  7. Format paragraphs 
 
88) The feature that automatically corrects mistakes as you type is called ________. 
Answer:  AutoCorrect 
Diff: 1    Page Ref: 151 
Objective:  8. Proofread a document 
 
89) The ________ Pane includes a set of related features that help the user get around a 
document and search for content. 
Answer:  Navigation 
Diff: 2    Page Ref: 153 
Objective:  8. Proofread a document 

90) A(n) ________ symbol can be used to represent characters and numbers when using the Find 
and Replace feature. 
Answer:  wildcard 
Diff: 2    Page Ref: 154 
Objective:  8. Proofread a document 
 
91) A(n) ________ consists of one or more lines of text or graphics printed in the top margin of a 
document. 
Answer:  header 
Diff: 1    Page Ref: 156 
Objective:  9. Insert a header and a footer 
 
92) A(n) ________ consists of one or more lines of text or graphics printed in the bottom margin 
of a document. 
Answer:  footer 
Diff: 1    Page Ref: 156 
Objective:  9. Insert a header and a footer 
 
93) ________ computing permits users to save files on the Internet instead of the user's 
computer. 
Answer:  Cloud 
Diff: 2    Page Ref: 159 
Objective:  10. Save and close a document, and print a document 
 
94) ________ is 15GB of web storage space that Microsoft makes available free of charge. 
Answer:  OneDrive 
Diff: 2    Page Ref: 159 
Objective:  10. Save and close a document, and print a document 
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95) A file type that maintains most formatting attributes of a source document is ________. 
Answer:  PDF, Portable Document Format 
Diff: 2    Page Ref: 159 
Objective:  10. Save and close a document, and print a document 
 
96) Match the following business letter components with their definition. 
 
I. Heading  
II. Reference  
III. Salutation  
IV. End notation  
V. Inside address  
 
A. One or more abbreviations or phrases that have important functions 
B. Includes the writer's address and the date of the letter 
C. Shows the name and address of the recipient of the letter 
D. Directly addresses the recipient by title and last name 
E. Subject line 
Answer:  B, E, D, A, C 
Diff: 2    Page Ref: 133 
Objective:  3. Work with business correspondence 

97) Match the following document views with their definition. 
 
I. Print Layout  
II. Web Layout   
III. Outline view  
IV. Draft view  
V. Read Mode  
 
A. Shows how a document will appear in a browser 
B. Shows the structure of a document in a hierarchical fashion 
C. Provides an approximation of how a document will look when printed 
D. Lets you define your column width, page color, and preferred layout 
E. Used to edit and format in a text-only environment 
Answer:  C, A, B, E, D 
Diff: 2    Page Ref: 135 
Objective:  4. Explore the Word interface 
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98) Match the following terms with their definition. 
 
I. Word wrap 
II. Soft return  
III. Hard return  
IV. Default setting  
V. Formatting mark  
 
A. Enables you to continue typing without pressing Enter 
B. Not shown when a document is printed 
C. Occurs when Enter is pressed  
D. Automatically in place until you specify otherwise 
E. Occurs automatically 
Answer:  A, E, C, D, B 
Diff: 2    Page Ref: 135 
Objective:  4. Explore the Word interface 
 
99) Match the following keys with their resulting insertion point. 
 
I. Ctrl+Home  
II. Home  
III. End  
IV. Ctrl+End  
V. Backspace  
 
A. Beginning of the current line 
B. End of the current line 
C. Left one space  
D. Beginning of the document 
E. End of the document 
Answer:  D, A, B, E, C 
Diff: 2    Page Ref: 138 
Objective:  5. Insert and delete text 
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100) Match the following Backstage view actions with their definition. 
 
I. Info  
II. Account  
III. Options   
IV. Share 
V. Export  
 
A. Gain access to product information 
B. Save an open document in a different format, including PDF or XPS 
C. Customize Word preferences 
D. Send an open document through email, publish it as a blog post, or save to OneDrive for 
others to view 
E. View and set document properties and security permissions 
Answer:  E, A, C, D, B 
Diff: 2    Page Ref: 139 
Objective:  5. Insert and delete text 
 
101) Match the following keyboard shortcuts with their methods to selecting blocks of text. 
 
I. One word  
II. One sentence  
III. One paragraph  
IV. One line  
V. One block of text  
 
A. Double-click the word 
B. Position the pointer in the left margin beside the line to select; when the pointer becomes a 
white arrow, click to select the line 
C. Triple-click the paragraph 
D. Click where the selection is to begin, hold down Shift, and then click where the selection is to 
end 
E. Press and hold Ctrl while you click in the sentence 
Answer:  A, E, C, B, D 
Diff: 1    Page Ref: 141 
Objective:  6. Format characters 
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Your Office: Microsoft Office 2016 Volume 1 (Kinser) 

Access Chapter 1 

 

1) Microsoft ________ 2016 is Microsoft's most current database management system. 

A) PowerPoint 

B) Access 

C) Word 

D) Excel 

Answer:  B 

Diff: 1    Page Ref: 541 

Objective:  1. Understand the purpose of Access 

 

2) Facts about people, events, ideas, or things are ________. 

A) information 

B) data 

C) knowledge 

D) objects 

Answer:  B 

Diff: 2    Page Ref: 541 

Objective:  1. Understand the purpose of Access 

 

3) Facts that have been manipulated and have meaning become ________. 

A) information 

B) data 

C) knowledge 

D) objects 

Answer:  A 

Diff: 2    Page Ref: 541 

Objective:  1. Understand the purpose of Access 

 

4) Which of the following is NOT true about databases? 

A) In business, data is collected and used for decision making. 

B) Information is data that has been manipulated. 

C) A database eliminates the need for a paper-based system. 

D) Databases are used for operational processing and for analytical purposes. 

Answer:  C 

Diff: 3    Page Ref: 541 

Objective:  1. Understand the purpose of Access 

 

5) ________ are raw facts. 

A) Data 

B) Information 

C) Queries 

D) Objects 

Answer:  A 

Diff: 1    Page Ref: 541 

Objective:  1. Understand the purpose of Access 
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6) Which of the following is NOT true about the advantages that automated databases have over 

paper databases? 

A) The information in an automated database is much easier to find. 

B) Automated databases can be used to enforce accuracy and other quality standards. 

C) The information in an automated database can be manipulated and processed more rapidly. 

D) Paper databases make it easier for businesses to be competitive. 

Answer:  D 

Diff: 3    Page Ref: 541 

Objective:  1. Understand the purpose of Access 

 

7) The power of a(n) ________ is the ability to link tables to one another. 

A) suite 

B) ACCDB 

C) DBMS 

D) database 

Answer:  C 

Diff: 2    Page Ref: 541 

Objective:  1. Understand the purpose of Access 

 

8) In a database, data is stored in a ________. 

A) report 

B) form 

C) table 

D) query 

Answer:  C 

Diff: 2    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

9) You can use a database ________ to ask a question of the data. 

A) report 

B) form 

C) table 

D) query 

Answer:  D 

Diff: 2    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

10) The ________ view of a table displays the data stored in the table. 

A) Layout 

B) Datasheet 

C) Design 

D) Report 

Answer:  B 

Diff: 2    Page Ref: 542 

Objective:  1. Understand the purpose of Access 
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11) Each column in an Access table is called a(n) ________. 

A) record 

B) field 

C) piece 

D) section 

Answer:  B 

Diff: 1    Page Ref: 544 

Objective:  1. Understand the purpose of Access 

 

12) A(n) ________ is a specific piece of information that is stored in every record. 

A) record 

B) link 

C) attribute 

D) relationship 

Answer:  C 

Diff: 2    Page Ref: 544 

Objective:  1. Understand the purpose of Access 

 

13) A structure of a database that is already populated with tables, fields, forms, queries, and 

reports is a(n) ________. 

A) template 

B) DBMS 

C) starting file 

D) relationship 

Answer:  A 

Diff: 2    Page Ref: 544 

Objective:  1. Understand the purpose of Access 

 

14) The Navigation Pane is located on the ________ when Access is opened. 

A) top 

B) bottom 

C) right side 

D) left side 

Answer:  D 

Diff: 2    Page Ref: 545 

Objective:  2. Maneuver in the Navigation Pane 

 

15) To close the Navigation Pane, click the ________ Open/Close button. 

A) Layout view 

B) object 

C) Shutter Bar 

D) record selector 

Answer:  C 

Diff: 3    Page Ref: 545 

Objective:  2. Maneuver in the Navigation Pane 
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16) The Navigation ________ on the left side of the application allows you to view all the 

objects in a database. 

A) filter 

B) bar 

C) window 

D) Pane 

Answer:  D 

Diff: 2    Page Ref: 545 

Objective:  2. Maneuver in the Navigation Pane 

 

17) Access includes a ________ to make it easier to find objects in a larger database. 

A) Search box 

B) Help window 

C) Navigation bar 

D) Navigation Pane 

Answer:  A 

Diff: 3    Page Ref: 547 

Objective:  2. Maneuver in the Navigation Pane 

 

18) The file ________ for an Access database is .accdb. 

A) extension 

B) name 

C) location 

D) path 

Answer:  A 

Diff: 1    Page Ref: 548 

Objective:  2. Maneuver in the Navigation Pane 

 

19) The file extension for a 2002-2003 Access database file that is in "execute only" mode is 

________. 

A) accde 

B) mdb 

C) mde 

D) accdt 

Answer:  C 

Diff: 3    Page Ref: 548 

Objective:  2. Maneuver in the Navigation Pane 

 

20) The file extension for an Access database template is ________. 

A) accde 

B) mdb 

C) mde 

D) accdt 

Answer:  D 

Diff: 2    Page Ref: 548 

Objective:  2. Maneuver in the Navigation Pane 
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21) The process of copying data from another file into a database is known as ________. 

A) importing 

B) filing 

C) inserting 

D) reconciling 

Answer:  A 

Diff: 1    Page Ref: 549 

Objective:  3. Understand the purpose of tables 

 

22) All of the following can be performed in Excel EXCEPT: 

A) manage data. 

B) perform calculations. 

C) relate worksheets. 

D) report on data. 

Answer:  C 

Diff: 2    Page Ref: 555 

Objective:  3. Understand the purpose of tables 

 

23) The Navigation ________ makes it easy for you to move through records in a table. 

A) file 

B) window 

C) bar 

D) Pane 

Answer:  C 

Diff: 1    Page Ref: 552 

Objective:  4. Manually navigate a database 

 

24) A ________ is used to ask a question of the data. 

A) report 

B) table 

C) query 

D) form 

Answer:  C 

Diff: 2    Page Ref: 559 

Objective:  5. Understand the purpose of queries 

 

25) A ________ helps create objects using a step-by-step process. 

A) template 

B) shortcut 

C) file extension 

D) wizard 

Answer:  D 

Diff: 2    Page Ref: 559 

Objective:  5. Understand the purpose of queries 
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26) An Access wizard is a(n) ________. 

A) type of template 

B) shortcut to building objects 

C) storage methodology 

D) operator 

Answer:  B 

Diff: 3    Page Ref: 559 

Objective:  5. Understand the purpose of queries 

 

27) The ________ view shows the query's structure. 

A) Query Results 

B) SQL 

C) Datasheet 

D) Design 

Answer:  D 

Diff: 2    Page Ref: 562 

Objective:  5. Understand the purpose of queries 

 

28) The ________ operator in a query selects the records in which the field values listed are 

within the two values. 

A) Between 

B) < > 

C) > = 

D) < = 

Answer:  A 

Diff: 1    Page Ref: 565 

Objective:  5. Understand the purpose of queries 

 

29) The ________ operator in a query selects the records in which the field value is not equal to 

the value provided. 

A) Between 

B) < > 

C) > = 

D) < = 

Answer:  B 

Diff: 1    Page Ref: 565 

Objective:  5. Understand the purpose of queries 

 

30) If no sort criteria is specified when creating a query, Access will sort the results by the 

________.  

A) first text field 

B) first numeric field 

C) foreign key 

D) primary key 

Answer:  D 

Diff: 3    Page Ref: 565 

Objective:  5. Understand the purpose of queries 
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31) Query results can be printed from the ________ tab. 

A) File 

B) Home 

C) View 

D) Create 

Answer:  A 

Diff: 1    Page Ref: 566 

Objective:  5. Understand the purpose of queries 

 

32) The view used to add or edit data in a form is ________. 

A) Form 

B) Layout 

C) Design 

D) Print 

Answer:  A 

Diff: 1    Page Ref: 567 

Objective:  6. Understand the purpose of forms 

 

33) To view a form and the data, click ________ view. 

A) Form 

B) Layout 

C) Design 

D) Print 

Answer:  B 

Diff: 2    Page Ref: 567 

Objective:  6. Understand the purpose of forms 

 

34) To see how a report would look on a piece of paper, open the report in ________. 

A) Report view 

B) Print Preview 

C) Layout view 

D) Design view 

Answer:  B 

Diff: 2    Page Ref: 570 

Objective:  7. Understand the purpose of reports 

 

35) To see how a report would look in a continuous page layout, open the report in ________. 

A) Report view 

B) Print Preview 

C) Layout view 

D) Design view 

Answer:  A 

Diff: 2    Page Ref: 570 

Objective:  7. Understand the purpose of reports 
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36) Reports have ________ views. 

A) two 

B) three 

C) four 

D) five 

Answer:  C 

Diff: 3    Page Ref: 570 

Objective:  7. Understand the purpose of reports 

 

37) A(n) ________ database is an extra copy of a database that you keep just in case something 

happens to the original one. 

A) repaired 

B) compacted 

C) backup 

D) advance 

Answer:  C 

Diff: 2    Page Ref: 574 

Objective:  8. Back up a database 

 

38) The Back Up Database command is located on ________ view. 

A) Report 

B) Backstage 

C) Form 

D) Datasheet 

Answer:  B 

Diff: 2    Page Ref: 574 

Objective:  8. Back up a database 

 

39) ________ an Access database rearranges objects so disk space is used more efficiently. 

A) Backing up 

B) Recovering 

C) Compacting 

D) Saving 

Answer:  C 

Diff: 2    Page Ref: 575 

Objective:  9. Compact and repair a database 

 

40) Which of the following is NOT true about compacting and repairing a database? 

A) The compact option also looks for damaged data and tries to repair it. 

B) There are four options for compacting a database. 

C) Compacting releases unused space to be used again. 

D) If you do not compact your database, it can become very large quickly. 

Answer:  B 

Diff: 3    Page Ref: 575 

Objective:  9. Compact and repair a database 
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41) A database is a collection of the data that companies spend a lot of time and money on 

gathering. 

Answer:  TRUE 

Diff: 1    Page Ref: 541 

Objective:  1. Understand the purpose of Access 

42) Data is an important asset to any organization after it is converted to information. 

Answer:  TRUE 

Diff: 2    Page Ref: 541 

Objective:  1. Understand the purpose of Access 

 

43) Databases are used for operational processing and for analytical purposes. 

Answer:  TRUE 

Diff: 2    Page Ref: 541 

Objective:  1. Understand the purpose of Access 

 

44) Operational databases are used for extracting data for decision making. 

Answer:  FALSE 

Diff: 3    Page Ref: 541 

Objective:  1. Understand the purpose of Access 

 

45) Every time Joe's customers purchase an item, he stores the sale in a database. The best option 

for him is to use an analytical database. 

Answer:  FALSE 

Diff: 2    Page Ref: 541 

Objective:  1. Understand the purpose of Access 

 

46) A DBMS and database are synonymous. 

Answer:  FALSE 

Diff: 2    Page Ref: 541 

Objective:  1. Understand the purpose of Access 

 

47) You can easily integrate Access with other products in the Office suite. 

Answer:  TRUE 

Diff: 2    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

48) Access has six main objects. 

Answer:  FALSE 

Diff: 2    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

49) Data is always stored in a form. 

Answer:  FALSE 

Diff: 1    Page Ref: 542 

Objective:  1. Understand the purpose of Access 
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50) A table organizes data in columns and rows. 

Answer:  TRUE 

Diff: 1    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

51) A query is another word for a question. 

Answer:  TRUE 

Diff: 3    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

52) What you learn about one relational database can be transferred to other relational databases. 

Answer:  TRUE 

Diff: 2    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

53) A form pulls records from a table in an easy-to-read format suitable for printing. 

Answer:  FALSE 

Diff: 2    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

54) A report allows you to enter, edit, and delete data. 

Answer:  FALSE 

Diff: 2    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

55) The data contents within a table can be seen in Design view. 

Answer:  FALSE 

Diff: 2    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

56) A record is all of the data pertaining to one person, place, thing, or event. 

Answer:  TRUE 

Diff: 1    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

57) A column in an Access table is called a characteristic. 

Answer:  FALSE 

Diff: 2    Page Ref: 544 

Objective:  1. Understand the purpose of Access 

 

58) Relationships are links between the tables. 

Answer:  TRUE 

Diff: 1    Page Ref: 544 

Objective:  1. Understand the purpose of Access 

 



11 

Copyright © 2017 Pearson Education, Inc. 

59) A template can be used as a starting point when creating a new database. 

Answer:  TRUE 

Diff: 1    Page Ref: 544 

Objective:  1. Understand the purpose of Access 

 

60) The Navigation Pane is used to navigate through a table. 

Answer:  FALSE 

Diff: 1    Page Ref: 545 

Objective:  2. Maneuver in the Navigation Pane 

 

61) Access 2016 uses a different file extension than previous versions of Access. 

Answer:  FALSE 

Diff: 2    Page Ref: 548 

Objective:  2. Maneuver in the Navigation Pane 

62) When you create relationships in a relational database, you give it power. 

Answer:  TRUE 

Diff: 2    Page Ref: 549 

Objective:  3. Understand the purpose of tables 

 

63) If you want to insert data from another file into an Access database, you must use copy and 

paste. 

Answer:  FALSE 

Diff: 1    Page Ref: 549 

Objective:  3. Understand the purpose of tables 

 

64) If you have redundant data in your database, then you have duplicate data that should be 

corrected or deleted. 

Answer:  TRUE 

Diff: 3    Page Ref: 555 

Objective:  3. Understand the purpose of tables 

 

65) Because there are many Access functions that use a table and will not work if the table is 

open, it is best practice to close a table when you are finished working with it. 

Answer:  TRUE 

Diff: 3    Page Ref: 558 

Objective:  4. Manually navigate a database 

 

66) Backing up a database will help protect you against any mishaps with the original database 

such as accidental loss of data. 

Answer:  TRUE 

Diff: 2    Page Ref: 574 

Objective:  8. Back up a database 
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67) A table organizes data in ________ and rows. 

Answer:  columns 

Diff: 1    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

68) A(n) ________ pulls records from a table in an easy-to-read format suitable for printing. 

Answer:  report 

Diff: 2    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

69) The data contents within a table can be seen in ________ view. 

Answer:  Datasheet 

Diff: 2    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

 

70) A(n) ________ is all of the data pertaining to one person, place, thing, or event. 

Answer:  record 

Diff: 1    Page Ref: 542 

Objective:  1. Understand the purpose of Access 

71) A column or field in an Access table is also known as a(n) ________. 

Answer:  attribute 

Diff: 2    Page Ref: 544 

Objective:  1. Understand the purpose of Access 

 

72) A database that includes linked tables is said to be a(n) ________ database. 

Answer:  relational 

Diff: 2    Page Ref: 549 

Objective:  3. Understand the purpose of tables 

 

73) The process of copying data from another file, like a Word document, into an Access 

database is called ________. 

Answer:  importing 

Diff: 2    Page Ref: 549 

Objective:  3. Understand the purpose of tables 

 

74) To move through the data in a table, Access provides a(n) ________ at the bottom of the 

table. 

Answer:  Navigation bar 

Diff: 2    Page Ref: 552 

Objective:  3. Understand the purpose of tables 

 

75) The import data options are located on the ________ tab. 

Answer:  External Data 

Diff: 1    Page Ref: 550 

Objective:  3. Understand the purpose of tables 
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76) The ________ row at the end of a table allows you to enter new records into the table. 

Answer:  append 

Diff: 2    Page Ref: 553 

Objective:  3. Understand the purpose of tables 

 

77) Data ________ is created through repetition and causes inefficiencies. 

Answer:  redundancy 

Diff: 3    Page Ref: 555 

Objective:  3. Understand the purpose of tables 

 

78) Redundant information leads to ________. 

Answer:  errors 

Diff: 1    Page Ref: 555 

Objective:  3. Understand the purpose of tables 

 

79) Before working in a database, it is beneficial to explore the database ________. 

Answer:  manually 

Diff: 2    Page Ref: 556 

Objective:  4. Manually navigate a database 

 

80) To create objects, a(n) ________ can be used to serve as a step-by-step guide. 

Answer:  wizard 

Diff: 2    Page Ref: 559 

Objective:  5. Understand the purpose of queries 

81) The Query Wizard uses a(n) ________ dialog box to create a query. 

Answer:   question-and-answer  

Diff: 3    Page Ref: 562 

Objective:  5. Understand the purpose of queries 

 

82) To remember what a query does, make the name as ________ as possible. 

Answer:  descriptive 

Diff: 3    Page Ref: 562 

Objective:  5. Understand the purpose of queries 

 

83) The top half of the window in a query's design view is the Query ________. 

Answer:  workspace 

Diff: 2    Page Ref: 563 

Objective:  5. Understand the purpose of queries 

 

84) The bottom half of the window in a query's design view is the Query ________. 

Answer:  design grid 

Diff: 2    Page Ref: 563 

Objective:  5. Understand the purpose of queries 
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85) The top row in the Query design grid is the ________. 

Answer:  Field name 

Diff: 3    Page Ref: 563 

Objective:  5. Understand the purpose of queries 

 

86) If no sorting sequence is specified when creating a query, Access will sort the results of the 

query by the ________. 

Answer:  primary key 

Diff: 3    Page Ref: 565 

Objective:  5. Understand the purpose of queries 

 

87) To print query results, click the ________ tab. 

Answer:  File 

Diff: 1    Page Ref: 566 

Objective:  5. Understand the purpose of queries 

 

88) ________ view shows the data in a form and allows for data entry. 

Answer:  Form 

Diff: 1    Page Ref: 567 

Objective:  6. Understand the purpose of forms 

 

89) ________ view shows how a report would look in a continuous page layout. 

Answer:  Report 

Diff: 2    Page Ref: 570 

Objective:  7. Understand the purpose of reports 

 

90) To see how a report would look on a printed page, go to Print ________. 

Answer:  Preview 

Diff: 2    Page Ref: 570 

Objective:  7. Understand the purpose of reports 

91) An extra copy of a database is called a(n) ________ database. 

Answer:  backup 

Diff: 2    Page Ref: 574 

Objective:  8. Back up a database 

 

92) Backup options are available on ________ view. 

Answer:  Backstage 

Diff: 2    Page Ref: 574 

Objective:  8. Back up a database 

 

93) To rearrange objects so disk space is used more efficiently, you should ________ the 

database. 

Answer:  compact 

Diff: 2    Page Ref: 575 

Objective:  8. Back up a database 
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94) Match the following terms with their definition. 

 

I. Database 

II. Data 

III. Information 

IV. DBMS 

V. Object 

 

A. A software program 

B. A collection of records 

C. Can be a table, query, form, or report 

D. Can be used to gain a competitive advantage 

E. Facts about people, events, things, or ideas 

Answer:  B, E, D, A, C 

Diff: 2    Page Ref: 541-542 

Objective:  1. Understand the purpose of Access 

 

95) Match the following terms with their definition. 

 

I. Table 

II. Query 

III. Form 

IV. Report 

V. View 

 

A. Allows you to ask questions about the data 

B. Allows you to easily enter new records 

C. Stores data organized in columns and rows 

D. Different perspective and different capabilities 

E. An easy-to-read format suitable for printing 

Answer:  C, A, B, E, D 

Diff: 2    Page Ref: 542 

Objective:  1. Understand the purpose of Access 
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96) Match the following terms with their definition. 

 

I. Datasheet view 

II. Design view 

III. Field 

IV. Navigation Pane 

V. File extension 

 

A. Shows the data contents within a table 

B. A suffix 

C. An attribute 

D. Allows you to view the objects in the database 

E. Shows how fields are defined 

Answer:  A, E, C, D, B 

Diff: 2    Page Ref: 542-545, 548 

Objective:  Various 

 

97) Match the following file extensions with their definition. 

 

I. accdb 

II. accde 

III. accdt 

IV. mdb 

V. mde 

 

A. Access 2007-2016 database file that is in "execute only" mode 

B. Access database template 

C. Access 2002-2003 database file that is in "execute only" mode 

D. Access database file 

E. Access 2002-2003 database file 

Answer:  D, A, B, E, C 

Diff: 3    Page Ref: 548 

Objective:  2. Maneuver in the Navigation Pane 
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98) Match the following terms with their definition. 

 

I. Relational database 

II. Navigation bar 

III. Data redundancy 

IV. Error 

V. Loss of data 

 

A. Allows you to move through a table 

B. Caused by deleting data 

C. Duplicate data 

D. Caused by redundant information 

E. Data is stored in linked tables 

Answer:  E, A, C, D, B 

Diff: 2    Page Ref: 549, 552, 555 

Objective:  3. Understand the purpose of tables 

99) Match the following selection criteria with their description. 

 

I. = 

II. <= 

III. >= 

IV. <> 

V. Between 

 

A. If no operator is used, this is assumed 

B. Selects records in which the field value is not equal to the value provided 

C. Selects records in which the field value is greater than or equal to the value provided 

D. Selects records in which the field values listed are within the two values 

E. Selects records in which the field value is less than or equal to the value provided 

Answer:  A, E, C, B, D 

Diff: 2    Page Ref: 565 

Objective:  5. Understand the purpose of queries 
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100) Match the following terms with their definition. 

 

I. Form view 

II. Design view 

III. Report view 

IV. Print Preview 

V. Layout view 

 

A. Can view and edit the appearance without seeing the data 

B. Used to enter or change data 

C. Shows a continuous page layout 

D. Some parts of the design can be changed in this view 

E. This view allows you to change the page layout 

Answer:  B, A, C, E, D 

Diff: 3    Page Ref: 567, 570 

Objective:  Various 
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